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Software License Agreement

This Software License Agreement (“License Agreement”) isalegal agreement between you (either
anindividua or asingle entity) and Serif, Inc. (“ Serif”) for the accompanying software product,
which includes computer software and may include associated media, printed materials, and
“onling” or electronic documentation (the “ Software Product”). By installing, copying, or otherwise
using the Software Product, you agree to be bound by the terms of this License Agreement. If you
do not agree to the terms and conditions of this License Agreement, do not install or use the
Software Product; you may, however, return it to your place of purchase for afull refund.

THANK YOU FOR LICENSING THE USE OF THE SOFTWARE PRODUCT. IT IS
IMPORTANT THAT YOU (THE “LICENSEE") READ THIS NOTICE CAREFULLY. THESE
ARE THE ONLY TERMS AND CONDITIONS APPLICABLE TO YOUR RIGHTSWITH
RESPECT TO THE SOFTWARE PRODUCT. THE SOFTWARE PRODUCT ISPROTECTED BY
COPYRIGHT LAWS AND INTERNATIONAL COPYRIGHT TREATIES, ASWELL ASOTHER
INTELLECTUAL PROPERTY LAWS AND TREATIES. THE SOFTWARE PRODUCT IS

LICENSED, NOT SOLD.

1. GRANT OF LICENSE

Serif hereby grantsto Licensee a personal, non-exclusive, non-
transferable license (a“License”) to use one (1) copy of the
Software Product, including any updates thereto, and
accompanying documentation, if any, provided by Serif,
according to the terms set forth below. If the Software Product
isbeing provided to Licensee as an update or upgrade to
software which Licensee has previously licensed (such software
referred to as the “Prior Software”), then Licensee agrees to
destroy al copies of the Prior Software within thirty (30) days
after opening this package except for one backup copy of the
Prior Software.

2. SCOPE OF USE

Y ou may install and use one copy of the Software Product, on a
single computer. The primary user of the computer on which
the Software Product is installed may make a second copy for
his or her exclusive use on a portable computer. Licensee may
aso store or install a copy of the Software Product on a storage
device, such as anetwork server, used only to install or run the
Software Product on other computers over an internal network;
however, you must acquire and dedicate alicense for each
separate computer on which the Software Product isinstalled or
run from the storage device. A license for the Software Product
may not be shared or used concurrently on different computers.

3. LICENSE PAK

If you have acquired this LICENSE AGREEMENT in a Serif
License Pak, you may make the number of additional copies of
the computer software portion of the Software Product as
authorized in the Serif License Pak, and you may use each copy
in the manner specified above. Y ou are aso entitled to make a
corresponding number of secondary copies for portable
computer use as specified above.

4. PROHIBITIONS

Y ou may not: modify, prepare derivative works from, translate,
reverse engineer, decompile, disassemble or otherwise derive
source code from the Software Product (except to the extent that
such acts are expressly permitted by applicable law
notwithstanding this limitation); copy the Software Product
(except as provided above) or the accompanying
documentation; rent, transfer, disclose, make available or grant
any rightsin the Software Product (including any
accompanying documentation) in any form to any person
without the prior written consent of Serif; remove any
proprietary notices, labels, or marks on the Software Product
(including any accompanying documentation); use the Software
Product in any manner that infringes the intellectual property or

other rights of another party; or use the Software Product to
provide on-line or other database services to any other person.

5.RETENTION OF RIGHTS; TERMINATION

This License Agreement does not constitute asale. All title,
trade secrets, copyrights, patents and other intellectual rights to
the Software Product, its accompanying documentation and any
copy made by Licensee remain with Serif, and Licensee hereby
agrees to preserve and acknowledges the foregoing. Licensee
further agrees and acknowledges that the Software Product and
all copies thereof are Serif’s exclusive property and constitute a
valuable trade secret of Serif. Licensee further agrees and
acknowledges that unauthorized copying of the Software
Product or the accompanying documentation, or failure to
comply with any of the provisions hereof (each, a“Terminable
Event”), will result in automatic termination of this License. In
the event of aviolation of this License by Licensee, Serif
reserves and shall have available all legal remedies.

6. TERM OF LICENSE FOR TRIAL VERSION
SOFTWARE

The License pertaining to atrial version of the Software
Product (a“Tria Version”) shall expire in accordance with the
terms as set forth in the installation process for the Trial
Version along with the designated trial period as set forth in the
trial program.

7.LIMITED WARRANTY AND DISCLAIMER

Serif warrants that, for a period of ninety (90) days after
delivery, the diskettes or CD-ROMs on which the software
included in the Software Product is furnished will, under normal
use, be free from defects that prevent Licensee from loading the
Software Product on a computer. Serif's entire liability and
Licensee's exclusive remedy under this warranty will be, at
Serif' s option, to (&) use reasonable commercial effortsto
attempt to correct or work around errors, or (b) to replace the
Software Product with functionally equivalent Software
Product, on diskettes or CD-ROM, as applicable or (c) return
the price paid for the Software Product, in each case upon
return of the Software Product to Serif together with a copy of
your receipt for the purchase thereof. This Limited Warranty is
void if failure of the Software Product or hardware has resulted
from accident, abuse, or misapplication. Any replacement
Software Product will be warranted for the remainder of the
original warranty period or thirty (30) days, whichever is
longer. Outside the United States, neither these remedies nor
any product support services offered by Serif are available
without proof of purchase from an authorized non-U.S. source.
The Software Product is licensed to you on an “asis’ basis
without any warranty of any nature.



8.NO OTHER WARRANTIES

EXCEPT FOR THE ABOVE EXPRESS LIMITED
WARRANTIES, SERIF AND ITS SUPPLIERS MAKE AND
LICENSEE RECEIVES NO WARRANTIES OR
CONDITIONS, OR TERMS, EXPRESS, IMPLIED,
STATUTORY, OR IN ANY COMMUNICATION WITH
LICENSEE. TO THE MAXIMUM EXTENT PERMITTED BY
APPLICABLE LAW, SERIF AND ITS SUPPLIERS
DISCLAIM ALL OTHER WARRANTIES AND
CONDITIONS, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, IMPLIED
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE, TITLE AND NON-
INFRINGEMENT, WITH REGARD TO THE SOFTWARE
PRODUCT AND THE PROVISION OF OR FAILURE TO
PROVIDE SUPPORT SERVICES. LICENSEE SHALL BE
SOLELY RESPONSIBLE FOR THE SELECTION, USE,
EFFICIENCY AND SUITABILITY OF THE SOFTWARE
PRODUCT AND SERIF SHALL HAVE NO LIABILITY
THEREFOR. SERIF SHALL HAVE NO LIABILITY FOR,
NOR OBLIGATION TO INDEMNIFY LICENSEE
REGARDING ACTIONS ALLEGING THE INFRINGEMENT
OF PROPRIETARY RIGHTSBY THE SOFTWARE
PRODUCT. SERIF DOES NOT WARRANT THAT THE
OPERATION OF THE SOFTWARE PRODUCT WILL BE
UNINTERRUPTED OR ERROR FREE OR THAT THE
SOFTWARE PRODUCT WILL MEET LICENSEE'S
SPECIFIC REQUIREMENTS. The Limited Warranty gives
you specific legal rights. Y ou may have others, which vary from
state/jurisdiction to state/jurisdiction.

9. LIMITATION OF LIABILITY

IN NO EVENT WILL SERIF OR ITS SUPPLIERS BE
LIABLE FOR LOSS OF DATA, CORRUPTION, LOST
PROFITS, COST OF COVER, OR OTHER SPECIAL,
INCIDENTAL, PUNITIVE, CONSEQUENTIAL, OR
INDIRECT DAMAGES ARISING FROM THE USE OF THE
SOFTWARE PRODUCT (INCLUDING ANY
ACCOMPANYING DOCUMENTATION), HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY. THIS
LIMITATION WILL APPLY EVEN IF SERIF OR AN
AUTHORIZED DISTRIBUTOR HAS BEEN ADVISED OF
THE POSSIBILITY OF SUCH DAMAGE. IN NO EVENT
WILL SERIF SLIABILITY EXCEED THE AMOUNT PAID
FOR THE SOFTWARE PRODUCT. LICENSEE
ACKNOWLEDGES THAT THE AMOUNTS PAID BY
LICENSEE FOR THE SOFTWARE PRODUCT REFLECT
THISALLOCATION OF RISK. Some states or other
jurisdictions do not allow the exclusion or limitation of liability
for incidental or consequential damages, so the above
limitations and exclusions may not be applicable in certain
instances. None of the above affects the statutory rights of
licensees residing in the United Kingdom.

10. NOT FOR RESALE SOFTWARE

If the Software Product is labeled “Not for Resale” or “NFR,”
then, notwithstanding section 1 of this License, your use of the
Software Product is limited to use for demonstration, test, or
evaluation purposes.

11. NO RENTAL; OTHER TRANSFERS

Y ou may transfer this License to another computer or
workstation only on a permanent basis (that is, with no intent to
transfer again) provided the computer, workstation, or other
digital electronic device from which you have transferred this
License no longer accesses or otherwise utilizes the Software
Product, and the Software Product is used in accordance with
the terms of this License Agreement.

12. TERMINATION

Y ou may terminate this License Agreement at any time. Serif
may terminate this License Agreement if you fail to comply
with the terms and conditions of this License Agreement. In
either event, you must destroy all copies of the Software
Product.

13. UPGRADE

If this Licenseisan “Upgrade,” you must have avalid license
for the Prior Software for this License Agreement to be valid,
and this License Agreement must be used to replace such
license for the Prior Software. The total number of license
“Upgrades’ you may acquire may not exceed the total number
of computers, workstations, or other digital electronic devices
that were licensed to access or otherwise utilize the Software
Product at the time you upgraded the Software Product.

14. MISCELLANEOUS

This Agreement shall not be governed by the 1980 U. N.
Convention on Contracts for the International Sale of Goods;
rather, this Agreement shall be governed by the laws of the
State of New Jersey, of the United States of America, including
the Uniform Commercial Code of the State of New Jersey,
without reference to conflicts of law principles. This Agreement
isthe entire Agreement between Serif and Licensee and
supersedes any other communications or advertising with
respect to the Software Product. If any provision of this
Agreement is held invalid or unenforceable, such provision
shall be revised to the extent necessary to cure the invalidity or
non-enforceability, and the remainder of this Agreement shall
continue in full force and effect. If the Software Product is
acquired by the United States Government or on its behalf, the
Software is furnished with restricted rights. The use,
duplication, or disclosure by the United States Government and
parties acting on its behalf is governed by, and subject to
restrictions as set forth in subdivision (c) (1) (ii) of the Rightsin
Technical Data and Computer Software clause at DFARS
252.227-7013, the subparagraphs (c)(1) and (2) of the
Commercial Computer Software - Restricted Rights at 48 CFR
52.227-19, or other comparable regulations of other government
agencies, as applicable. Licensee agrees not to allow the
Software Product to be sent to or used in any other country
except in compliance with applicable United States laws and
regulations. This Agreement shall constitute the entire
agreement between Serif and Licensee and supersedes all prior
agreements, understandings, communications, proposals or
representations, oral or written, by either party. This Agreement
shall be amended only by an executed writing by authorized
representatives of both parties.



How to contact us
Our main office (USA, Canada):

The Software Center

PO Box 803, Nashua NH 03061 USA

Main (603) 889-8650

Registration (800) 794-6876

Single Unit Sales (800) 55-SERIF or 557-3743

Technical Support
Customer Service
General Fax

(603) 886-6642
(800) 489-6720
(603) 889-1127

Technical Support E-mail support@serif.com

European office (UK, Europe):

The Software Centre

PO Box 2000, Nottingham, NG11 7GW, UK

Main

Registration

Sales

Technical Support

(0115) 914 2000
(0500) 454 645

(0800) 376 4848
(0115) 914 9090

Customer Service
General Fax

(0115) 914 9090
(0115) 914 2020

Technical Support E-mail support@serif.co.uk

Online

Visit uson the Web at http://www.serif.com

International

Please contact your local distributor/dealer. For further details please
contact us at one of our phone numbers above.

Comments or other feedback

We want to hear from you! E-Mail feedback @serif.com with your
ideas and comments!
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Welcome

Ready to add a new dimension to your Web graphics projects,
presentations, or desktop publishing? 3DPlus 2.0 will take you there!

And

no special skills are required—whether you use Wizards to create

instant 3D elements and animations for you, or construct your own 3D
scenes. 3DPlus puts al the tools and resources you' |l need within easy
reach. To create, you just pick and choose, mix and match—customize
to your heart’s content. The professional-quality results will amaze

you!

About the Companion

This

Companion is your guide to getting started and getting results with

3DPlus—frominitia installation through advanced tips and examples.

1

Welcome. Read on for a feature summary—a checklist of the
fun that’sin store for you.

Installation and Startup. How to get up and running, and
create instant 3D designs and animations.

Working with 3D Scenes. First, some 3D basics. Then, give us
fifteen minutes... we'll put all our tools at your command.

Working with 3D Animation. How to add movement to your
static scenes for eye-catching 3D animations and movies.

Using 3DPluswith Other Software. How to incorporate your
3D creationsin graphics, presentation, or desktop publishing
programs.

What you’ll find in 3DPlus 2.0...

We've re-engineered 3DPlus from the ground up to blend state-of-the-
art capabilities into an even more convenient interface.

¢

New 3D Animation Capability

Make any 3D scene come dive! Simply place key frames for the
object properties you want to vary—Ilet 3DPlus generate the in-
between motion. Y our objects can move, rotate, change size or
color, and much more. The result: an animated GIF ready for your
Web site or presentation.
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¢ Improved Ease-of-Use
You'll appreciate the new Wizard interface that simplifies creating
new designs and animations, and the convenient, tabbed Studio bar
for tools and resources. Functions like rotation and extrusion have
been streamlined. And now you can select multiple objects, zoom
in or out with asingle click, and use WY SIWY G text entry to
preview fonts and formatting.

¢ Enhanced 3D Resources
Use the handy branching menus to browse a large set of 3D
models—from basic geometric shapes to complex man-made
objects. To customize your objects and scenes, choose from a new
collection of background images, an improved texture library, and
an expanded selection of lighting schemes.

¢ Improved 3D Tools
Try the new QuickShape tool for adjustable instant objects!
Choose from six preset camera angles, or ssimply drag for freeform
camera views and object rotations. Experiment with new lighting
types and controls for brilliant effects. Easily rotate, resize, and
move bitmap textures on any object.

¢ Performance Advances
Animproved 3D model format. Apply your choice of textures,
colors, and bevelsto complex clipart objects, with separate
material controls for front, sides, and back. Built-in DirectX ™
support affords speedier 3D rendering—and five anti-aliasing
quality levelslet you pick one that’s right for your system.

¢ Customizability
Now you can store your own custom lighting schemes, materials,
and bevels as Studio thumbnails, right there whenever you need
them. Import standard metafiles as 3D models, then weave them
into your scenes for awhole new range of design possibilities.

¢ Direct Output Preview
Forget the trial and error approach! The Export dialog now features
abuilt-in window so you can preview color depth, dithering, and
palette settings in a single step, before conversion. And for top-
quality Web GIFs, take advantage of transparency and background
anti-aliasing. And of course, you can embed 3DPlus scenes
directly in publications using OLE. Who said great results were
hard to come by?
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Registration, upgrades, and support

If you see the Registration Wizard when you launch 3DPlus, please take
amoment to complete the registration process. Just call Serif toll-free
and provide the installation number and code shown. We'll giveyou a
personalized registration number in return. Remember, if you need
technical support please contact us. We aim to provide fast, friendly
service and knowledgeable help.

Installation

What you need to run 3DPlus

Serif 3DPlus runs with Windows 95, 98, or 2000, so you’ll need a PC
setup that runs Windows adequately. If you need help installing
Windows or setting up your printer, refer to Windows documentation
and help (see below).

¢ IBM compatible Pentium PC with CD-ROM drive and mouse (or
other Microsoft compatible pointing device)
¢ Microsoft Windows® 95, 98, 98 SE, or 2000 operating system

¢ 16MB (Windows 95/98), 24MB (Windows 98 SE), or 64MB
(Windows 2000) RAM

¢ 40MB (recommended install) free hard disk space
¢ SVGA display (16-bit color) or higher

Additional disk resources and memory are required when editing large
or complex documents.

Optional componentsinclude:

¢ Windows-compatible printer
¢ TWAIN-compatible scanner and/or digital camera

¢ Internet account and connection required for accessing online
resources
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What you need to know

Don't worry if you’ ve never worked with 3D graphics software. 3DPlus
reguires no special knowledge. It's al based on WY SIWY G (What Y ou
SeelsWhat You Get), so WYDKCHY (What You Don't Know Can't
Hurt Y ou)! Follow along on the Companion’s guided tours and you'll
be up to speed in no time.

If you're new to Windows computing, you will find it much easier if,
before installing and using 3DPlus, you spend alittle time becoming
familiar with the operating environment.

O From the Windows desktop, click the Start button at the lower |eft
and choose Help.

First-time install

Toinstall Serif 3DPlus, simply insert the CD-ROM into your CD-ROM
drive. The AutoRun feature automatically starts the Setup process. (If it
doesn’t, follow the manual install procedure described below.)

Just answer the on-screen questionsto install the program. Y ou will be
given the choice between a Recommended install (which optimizes
performance by loading speed-critical filesto your hard drive for best
performance) or a Custom install (which lets you specify the files you
want copied to your hard drive).

3DPlus 2.0 Design CD-ROM

If you’' ve purchased the Design CD-ROM, we suggest you install it as
soon as you' ve finished installing from the Program CD-ROM. Again,
the AutoRun feature will automatically start the Setup when you insert
the Design CD-ROM into your drive.

Manual install/re-install

To re-install the software or to change any part of the installation at a
later date, select Settings/Control Panel from the Windows Start
menu and then click on the Add/Remove Programs icon. Make sure
the correct CD-ROM isinserted into your CD-ROM drive and then
simply follow the on-screen instructions. To install just one particular
component to your hard drive, choose the Custom option and check
only that component.
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Starting 3DPlus

Once 3DPlus has been installed, you’ll be ready to start. Setup adds a
Serif 3DPlus 2.0 icon to the Programs submenu of the Windows Start
menu.

W Use the Windows St ar t menu to start 3DPlus, or if 3DPlus is
already running choose New from the File menu.

Serif e

sz

QP e e S Wi et e

3DPlus launches and displays the Startup Wizard, with these options:

¢ Use a 3D Design WzardandUse a 3D Ani nation
W zar d let you preview and select a variety of cool effects, ready
for you to customize or use “as is.”

¢ Start from Scratch opens a blank scene window.
¢ (Open Saved Scene lets you browse and open your own files.

¢ Online Resources links you to the Serif Web sites.

If you’re just getting started with 3DPIlus, here’s a recommended
learning sequence:

1 From the Startup Wizard, choose one of the 3D Wizard options.

2  Follow the Wizard’s prompts to create an instant design or
animation (see the next section, Instant designs and animations).

3 To begin learning about 3DPlus tools and menus, just move the
mouse pointer around the screen. Watch the HintLine at the
bottom of the screen for capsule descriptions of each feature.
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4 Choose Help Contents from the Help menu to see what's

available in online help. The contents screen points you to the
extensive Visua Reference and How To sections. Click Help on
Help for some tips on how to proceed.

Refer to the following Companion chapters for self-paced, hands-
on tours of 3DPlustools and functions.

Instant designs and animations...

Creating amazing 3D effects that you can be proud of is easy with
3DPlus. Y ou can get started right away with the automated 3D
Wizards.

O Runthe Startup Wizard (File/New).

If the Startup Wizard fails to appear, check Use Startup Wizard on
the File/Preferences... screen, then try again.

For a 3D Design...

O From the Startup Wizard, click Use a 3D Design Wizard and

you'll see the Wizard categories displayed on the left. Browse
using the category menu and select a basic design from the
Wizards shown at the right. Then click Next> to move on to the
next section of the Wizard.

Type your own text, replacing the sample text, and click Next>. If
you change your mind or want to revisit the choices, click <Back
to retrace your steps.

On the following screens, make choices as
requested—for example, a bevel effect for
edges and a materia effect for surfaces—
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clicking Next> each time.

O Finaly, click abackground, then click Finish to complete the
Wizard sequence.

Y our new design appearsin the 3DPlus scene window.

For a 3D Animation...

r_|
- fO-
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U From the Startup Wizard, click Use a 3D Animation Wizard and
you'll seethe Wizard categories displayed on the left, with
animated previews on the right. Browse using the category menu
and select a basic animation. Then click Next> to move on to the
next section of the Wizard.

O Typeyour own text, replacing the sample text, and click Next>. If
you change your mind or want to revisit the choices, click <Back
to retrace your steps.

U Onthefollowing screens, make choices as requested—for
example, abevel effect for edges and a material effect for
surfaces—clicking Next> each time.

U Finaly, click Finish to
compl ete the Wizard
sequence.

Y our new animation appearsin
the 3DPIus scene window.

O Clickthe M Play button

on the Animation toolbar to
start playback. (To display
the Animation toolbar, choose Toolbars from the View menu and
check Animation on the submenu.)
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Choosing a driver setting

If you have aDirectX hardware driver installed on your system, 3DPlus
will use DirectX hardware acceleration to render scenes. Occasionaly,
driver or video adapter incompatibilities may lead to display problems
such as difficulty viewing materials on objects, or selecting a particular
light source. If such problems occur, or your scenes just don’t look the
way they should, try switching to the software driver setting.

To select the software driver, choose Preferences... from the File menu
and check the “ Software” option.



Dz E| 3&

Working with
3D Scenes



Working with 3D Scenes 15

It's a 3D world...

The best part of using 3DPlusisthat you can create terrific effects
without having to master all sorts of spatial concepts and computer
jargon. If you can grasp height, width, and depth, you’ re halfway
home! But learning any new program does involve a bit of trial and
error. Here' s some background to help minimize the “error” part.

The main 3DPlus window consists of a frame (with titlebar, menus,
etc.) enclosing a scene window. Imagine you're behind a video camera,
looking at a“set” with one or more objects positioned against a
background. The 3DPlus scene window is what you’ d see through the
camera’ s viewfinder. Asyou' d expect, there are toolsto let you
rearrange the objects, substitute a different background image, or
change the studio lighting for different effects. But that’s not all. With
3DPlus, you can instantly change an object’s colors and dimensions,
rotate it in space, apply cool surface textures, create your own mini-
universes of text and shapes, create animation... and more!

Background

Scene ,
objects

3D Plus
Scene window

New objects appear at the scene center. From the camera’ s viewpoint,
looking through the scene window, you see the objects in perspective.
Y ou can reposition objects to be nearer or farther away, and their sizes
change accordingly.

Y ou can aso place lights of various ,
types around the scene, and vary their

X X N Scene center
color and intensity for different effects.

9‘7 E_

""b%____- )
Lights
Viewpoint move

<]
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To set the width and height of the scene, choose Scene Setup... from
the File menu, or right-click on an empty part of the scene window and
choose Scene Setup.... Select aunit of measurement and enter the
width and height. Note that your screen resolution setting (800x600, for
example) will affect the actual size of the scene when it’ s printed.

At normal view level (1:1 or 100%), the size of the scene window you
see equals the size you' ve specified in Scene Setup. 3DPlus gives you
several ways of adjusting your working view without affecting the
actual scene size:

!§ To zoom in or out, choose the Zoom tool on the Tools toolbar,

then left-click on the scene window to zoom in, or right-click to zoom
out.

To adjust the scene window’ s size to fit within the main window
areg, click the Fit on Screen button on the Standard toolbar, or choose
Zoom from the View menu (or the scene’ s right-click menu) and select
Fit on Screen.

ﬂ To restore the scene window to its actual size, click the Normal

View (1:1) button on the Standard toolbar, or choose Zoom from the

View menu (or the scene’ s right-click menu) and select Normal View
(1:1).

Each three-dimensional object takes up space in three directions,
defined in 3D parlance asthe X, Y, and Z axes.

Think of the X axis as defining
the object’ swidth or left-to-right
dimension, andthe Y axisas
defining its height or top-to-
bottom dimension. For example,
theX and Y axes definethe
black character “&” in this text
object.

The Z axis defines the object’s
depth or front-to-back
dimension. It’sthisextra
dimension that givesus“3D.”

To learn how to manipulate these and other object properties, follow
along in the next section as we explore the 3DPlus interface.
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Guided Tour: 3D scenes

Tools
toolbar — |

Y ou’' ve seen how aWizard helps you create a simple 3D design or
animationinnotime at all. 3DPlusis so easy to use, with such
compelling effects, that you' re sure to want to experiment on your own.
Starting from scratch with a new scene is nearly assimple as using a
Wizard!

Whether you' re adding finishing touches to a Wizard-based creation or
pushing the limits of your own creativity, the following guided tour
will help you get up to speed. We'll use A checkbox bullets to mark
the ongoing tutorial thread—steps we'd like you to complete as you
follow along with the text. Save your work occasionally as you go
along.

The main purpose of thistour isto introduce you to the various tools—
not to make you an expert! For additional details on each tool and
procedure, be sure to consult online help’s Visual Reference and How
To sections.

Making a scene
We'll begin by creating a new, blank scene window.

O Start 3DPlusor, if it's already running, choose New from the File
menu, and select the “ Start from Scratch” Wizard option. )

Y our screen will look something like the illustration below. We've
resized the main window to bring the tools a bit closer to the scene
window. Y ou can aso click the Fit to Screen button to
maximize the working area.

O Takeamoment to identify the Toolstoolbar on theleft side of the
window, and the Studio tabs on theright.

-l'llﬂ HBE -

L Studio
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The lattice of bluelinesisthe floor grid, a plane that slices through the
scene center at the zero point of the scene’s'Y (vertical) axis. Initially,
the camerais elevated five degrees above this plane, affording a
perspective view. For the moment, we don’t need either the grid or the
Animation toolbar, so we can hide them.

O Right-click anywhere in the blank scene and uncheck Grid on the
menu.

O If the Animation toolbar isvisible, click its Close button to hideit.

The object of the exercise
Adding 3D models, also called “ objects,” to the sceneis a snap!

O Click the Studio’s Models tab to reveal the Basic Shapes category.
Click the Pyramid shape (third row down in the middle).

3DPlus locates the model on the CD-ROM and creates a new pyramid
object at the scene center. (For future reference, you can also drag
models from the Models tab and drop them at a specific position.)

The pyramid, like all the basic shapes, has awhite color by default, and
no special texture or other attributes. Initially, what you seeisafront
view of the object, which iswhy it looks like atriangle. Let’s prove
that it really has three dimensions.

The right tool for the job

a On the Tools toolbar at the left, click the button for the
@ Rotate tool. Immediately, a set of labels appears,
centered on the pyramid. (If you don’t see the labels
right away, just click on the pyramid to select it.)

The labels and lines plot the three axes of the
3D scene. Asyou might expect, the X axisis
horizontal, the Y axis runs vertically, and the Z
axis—the depth plane—runs straight from our
viewpoint into the scene center, which iswhy
we can't seeitsaxisline.

O Click onthe“Y" axislabel with the Rotate
cursor, being sureto click with the cursor’s
“hotspot”—asingle dot, as shown here. Drag
from side to side, then up and down. Now try the
same thing, only dragging the “X" axislabel, and
thenthe“Z" axislabel.

And thereit is: 3D!

Hotspot
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Asyou've probably noticed, dragging up has
the same effect as dragging to the right; the
down and left mouse actions are similarly
paired, a 3DPlus convention.

By the way, 3DPlus features multiple levels of
undo (which you can set in File/Prefer-

ences...)—S0 if you seem to have rotated your
pyramid hopelessly out of alignment, you can always backtrack...

Let’s continue to explore the offerings on the Tools toolbar, using the
pyramid as a sort of geometric guinea pig.

a Click to select the Move/Size tool.

Asits name implies, thistool handles two functions. If you click
directly on an object, you can drag it around in the scene along the X or
Y axes. (Its distance from the camera, or Z-distance, doesn’t change.)
Alternatively, you can click one of the object’ s handles—the red dots at
the corners of the selection—and drag to resize it. (In this case, the
object responds by growing or shrinking in three dimensions, although
its center doesn’'t move.)

O Try moving and resizing the pyramid. Watch for the special cursor
that appears when you' re over a handle: it tells you that dragging
will result in aresize operation.

Before proceeding, let's make life a bit more interesting by adding a
second object to the scene—this time, a QuickShape.

a Click the little down arrow on the Insert QuickShape
D 7| tool, third from the bottom on the Tools toolbar. (The
actual button icon varies, depending on which shape
you selected most recently.) From the flyout menu that appears,

choose the “Moon” shape (third row, left). The cursor changesto a
light bulb icon.

O Click in the scene window and drag
sideways with the light bulb cursor
until a crescent shape appearsand is
roughly as big as the pyramid object.
When you rel ease the mouse button,
you'll see adlider and two small buttons.

Y ou can adjust the outline of any QuickShape by dragging its slider(s).
In this case, the single dlider varies the “ phase” of the moon object.
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U Experiment with the dider, leaving the
moon as atypical thin crescent shape. Then
click thel=! button to confirm the shape.
(Clicking B would cancel it.)

Aswith the pyramid earlier, the moon object
initially appearsin straight-on front view.

Q Usethe Rotate tool to swivel the moon to a
more interesting angle.

The next item on the Tools toolbar is the Stretch tool, which
E\ lets you adjust a single object’s size along one dimension at a
time—for example, to make it thicker or thinner without
changing its height or width.

U Select the Stretch tool and click on the moon object.

Again, you'll see axislabels; but this time they represent the axes of the
object itself, asit’s currently positioned in space. To make an object
wider, drag out on its X axis. To reduce its height, drag down onits Y
axis, and so on.

U Experiment with the tool until you get accustomed to the changes
aong each axis. Then return the moon to its original shape, more
or less.

U Choose the Move/Size tool and drag the
moon down until it intersects the pyramid.
Both objects are till centered the same
distance from the camera; where they take
up the same space, they overlap with
intriguing results.

— The Distance tool lets you move an object’s center along the

] > scene' s Z axis—in other words move it closer to (or further

= from) the camera viewpoint. This|ets you place one object in
front of another in your scenes.

U Choose the Distance tool and click on the moon object to select it.
Now drag the object slightly down (or right). Doing so decreases
the Z-distance and brings the object closer; dragging up or left
pushes the object away. Although the object appears to grow or
shrink, bear in mind that it hasn’t actually changed size—only
position.
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4 TIP: Inworking with objects,
, . To choose: Press:
you'll often find yourself -
switching between the first four Move/Sizetool  Ctrl+1
tools on the Tools toolbar. Rotat(;tooll Ct’:+2
Use the shortcuts shown at right gretc too | E"I:i
to jump quickly from one tool to Istance too tr

another.

a Next, click the Text tool. Immediately, atext edit
m window pops up. Type a couple of words (we chose
“Nile Style”) and pick afont from the drop-down list
(we applied Stylistic SF). Click OK.

The text you typed appears in the scene as
anew text object (front view, of course.)

U Usethefour basic tools (Move/Size,
Rotate, etc.) to adjust the text and
placeit in relation to the other
objects.

Y ou can edit any text object by selecting
it, then using the controls on the Standard
toolbar to change font, alignment, and so
on. To bring up the text edit window
again, simply double-click the text
object—then you can retype the text as
needed.

TIP: You can select multiple objects by holding down the Shift key
when selecting each object, or by dragging out a marquee around a
group of objects. Then use any of the basic toolsto edit the resulting
multiple selection asiif it were asingle object.

So far, we' ve covered tools that affect selected objects in the scene.
The Tools toolbar also includes two tools that let you alter the camera
viewpoint, thus changing the appearance of the scene asawhole. Let's
take a quick look.

O Clickinablank part of the scene to deselect all objects. Notice that
the HintLine readout below the scene now shows values for the
camera.

The current “ cameraangle” valueis given as “0°5%”, denoting a5
degree elevation in the vertical plane. Thisisthe default starting
camera angle for new scenes, and we haven’t changed it since starting
the tour.
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a ‘ Click the down arrow on the Camera Angle tool. A
7| flyout menu appears, with seven choices. Move the
cursor over the choices and you' Il see six of them are
preset camera angles: Front, Back, Top, Bottom, Left, Right.

U Click each of the preset buttonsin turn and watch as the scene
changes. Asyou do so, keep an eye on the HintLine readout.

The Hintline values describe how far the camerd s position deviates
from the straight-on Front view (which is“0° 0°"). If the camera moves
horizontally from this Front view, the first value changes; verticaly,
and the second value changes. (For more, see the online help topic on
the Camera Angle tool.)

Besides the six preset viewpoints, you can use the Camera Angle tool
in freeform mode to display the scene from any viewpoint.

O Onthe Camera Angle flyout, click the
Freeform choice, and you'll seethe
scene jump back to theinitial “0° 5%
view. Then drag freely in the scene
window. You'll seethe view change
continuously, following your mouse
movements.

Note that the Freeform button
“remembers’ your last freeform angle, allowing you to select one of the
preset angles and then quickly return to the freeform viewpoint.

a Finally, choose the Camera Distance tool and drag in
the scene window. Again, the whole scene changes. This
adjustment can be useful for trimming (or adding) extra
space around the edges of the scene.

Some local color

Up to this point, we' ve been content to leave all the objects in the scene
in their original, rather pallid condition. And in fact, we've got anice
grayscale composition going. But before concluding the tour, let’s liven
things up abit.

In 3DPlus, there are three basic ways of adding color to a scene. Each
involves using one or more of the Studio tabs on the right side of the
workspace.
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To... You can...
Change the scene Use the Backgroundstab to select a solid
background color or image as a background

Change the base color Usethe Materialstab to select abase color
of individual objects for a selected object

Change the scene’s Use the Gallery to select a preset lighting
color scheme scheme, and/or
Use the Lightstab to customize the scene
lighting, adding lights of different colors

We'll look at a couple of these techniques by way of introducing the
Studio, and let you have fun exploring the others on your own.

o MEENAIS | i the Materials tab button.

When we speak of an object’s “material,” we're talking about a set of
surface properties that you can vary, and which are saved along with
the object. Base color isjust one of these properties. (The others are
texture, transparency, and shine.) The Materials tab lets you tweak an
object’s materia definition by adjusting each of these attributes
independently. For now, we'll just focus on color.

U Using any of the basic tools, select the moon object. Now click any
color swatch in the scrolling table at the bottom of the Materials
tab. Click another swatch.

With each click, the object’s color changes. (We prefer ayellow moon,
but you may have your own ideas!) By the way, the multi-colored
swatch at the upper left of the color table represents “Original Color”—
click it if you want to restore an object to itsinitial base color.

U Experiment with coloring each of the three objects in the scene
until you find a pleasing combination.

Shedding light on the situation

Taken together, all the lights used in a scene are known asthe scene's
lighting scheme—and every scene has one. In addition to the
Floodlight that’s standard in every new scene, 3DPlus provides four
different types of lights (Spot, Ambient, Distant, and Point) that you
can mix and match in any number or combination. Although each type
of light hasits own specia properties—detailed in online help—one
thing they have in common is the ability to take on a particular color.

Y ou can use multiple lights of different colors, in different positions, to
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create subtle interactions with the base colors of scene objects.

To get afed for how the lights work, let’ slook at a couple of them.

o (MRS T Gjick the Lights tab button and notice the scrolling
region in the center of the tab. At this point, there should be just

one entry: “Floodlight.” |_
9,

O Click thelight bulb icon
next to the light's name to turn off the light. The scene goes dark!
Click again to restore illumination.

O Inthe swatch panel at the bottom of the tab, click any color.

Now the sceneis bathed in avivid glow. Natice that the swatch to the
right of the “Floodlight” entry has now taken on the color you chose.
Changing the color of alight is as easy as changing an object’s base
color.

O Drag the Intensity slider to the left, and you'll see the scene fade
asthe floodlight’s output dims.

O Near thetop of the tab, click the Insert Spotlight button. Right
away you' |l see achangein the scene, as a spotlight object appears
in the center and casts a default hue of its own on the surroundings.

Spotlights, point lights, or distant lights that are turned on in a scene
appear as objects aslong asthe Lightstab is selected. Y ou can use the
basic toolsto reposition them. (Floodlights and ambient lights don’t
appear as objects.)

O Click thefloodlight’s bulb icon to
turn it off, so that only the spotlight
remains on. Using the Move/Size
tool, drag the spotlight object from
sidetoside. You'll findit'slike
shining aflashlight around in the
dark.

O Now try the Rotate and Distance tools
on the spotlight object. You'll see the
beam’ s width change as you move the
light in or out with respect to the scene.
Try swiveling the light to illuminate
specific objects. It helpsif you
visualize thelight asabulb inside a
housing, with its beam projecting
forward, as shown at right.
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Y ou can investigate the other light types at your convenience. We
suggest you continue the same approach: turn off everything but the
one light and then play around. (For details on each light type, search
for “lights’ in the online help index.)

In the meantime, let’ s not overlook that the Studio’s Gallery tab iswell
stocked with predefined lighting schemes, material definitions, and
bevels—so you may find exactly the effect you need without any extra
effort!

O Fromthe Lightstab, click the View Gallery button to open the
Gallery tab's Lights section directly. You'll see an array of
preview thumbnails, each depicting a different lighting scheme.

U Click afew thumbnailsin turn to see how each one affects the
scene. To see which lights and settings make up any particular
scheme, just click the Lights tab button. (It's another good way to
learn about the various light types.)

Finally, note that the Gallery includesa“My Gallery” section where
you can store your own custom lighting schemes and materials (there’s
a corresponding section on the Backgrounds tab, too). Saving custom
effectsis simply a matter of right-clicking on an object or scene.
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The easiest way to get started with animation is to choose the 3D
Animation Wizard option from the Startup Wizard screen. Once
you've selected and customized an animation, click Finish to bring it
into the scene window.

The Animation toolbar appears once you’ ve loaded an animation. (To
show or hide any toolbar manually, choose Toolbars from the View
menu and check or uncheck the item.) Y ou'll see that the Animation
toolbar consists of abasic Control Panel for playing back animations
and (when expanded) an Edit Panel which lets you edit existing
animations or create new ones. Y ou can drag the toolbar outside the
main window to increase the available workspace. Here' s the toolbar’s
Control Pandl:

Apimation

Flay
[ w0 ~] =] &)

The first set of three buttons are Play, Stop, and Pause/Resume. Use
these to preview the animation directly in the scene window. The
second set of buttons serve to set the playback mode. Click Single Run
to play the sequence once, stopping on the last frame. The next button,
Ping Pong, plays the sequence indefinitely—first forward, then
backward. Finaly, the Loop button also sets up an endless repeat
condition, this time repeating from the first frame each time.

3DPlus animations are just like static scenes, but with multiple
variations stored as frames. (We'll explain more about frames below.)
In order to use an animation on a Web page or in a presentation, you'l|
need to export it to a standard format known as animated GIF
(generally pronounced to rhyme with “riff”). Options that you set using
the Animation toolbar, such as playback mode and speed, are
incorporated into the animation when it's converted to a GIF.

Animation basics

To understand how animation works in 3DPlus, consider a basic 3D
scene with several objects. Instead of pointing a still camera at the
scene, imagine we' re using a movie camerathat lets us expose one
frame at atime. Between each exposure, we can adjust one or more of
the scene objects in various ways. We might change an object’s
position over time, so that it appeared to move from one side of the
scene to the other. Or we might change its rotation angle, so that a
sphere appeared to spin on its axis. Once we' ve shot a series of frames,
we can play them back rapidly and see the motion unfold.
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Creating animation in 3DPlusis afast and flexible process. In general,
you first decide how many frames you want in the sequence. Then you
issue instructions to the scene objects, telling them how to behave
during the sequence. Naturally, each object that will change needsits
own set of instructions. For each such object, you’ll specify which
properties need to vary, and define several key framesthat show the
object exactly as you want it to appear at that point in the sequence.
3DPlus takes care of the rest: it examines the key frames and
automatically generates “in-between” frames that take care of the
transformations. The result is a seamless animation.

For each object, you can set key frames for Position, Size, Rotation,
Texture, Color, and Transparency. For the scene as awhole, you can
set key frames for the two Camera properties, angle and distance. Take
amoment to think about the movements that could result from varying
each property: zooms and pans, pinwheels, flying planes, planetary
orbits, appearing and disappearing shapes, leaping lizards, exploding
text! To get started, try the following mini-lesson.

Guided Tour: 3D animation

Follow along with this step-by-step example and create a rotating
globe!

Around the world in 20 frames

O Choose New from the File menu (choose the “ Start from Scratch”
Wizard option) to start with anew, blank scene. If the floor grid is
visible, right-click in the scene and uncheck Grid to turn it off.

O Click the Studio’s Models tab and select the .
“Planets’ category. Click the “Earth” model’s
thumbnail and a globe object will appear in the
center of the scene, complete with seas and
continents. The African continent takes up most
of theright half of the globe. -

O Show the Animation toolbar (using View/Toolbars) if it's not
aready visible. Click the More button if necessary to reveal the
extended Edit Panel.

In the upper Frames group, note that the Total box is showing there are
20 frames in the sequence (the default value). The Current box shows
we're looking at frame 1, and so the adjacent Current Frame dlider is
set to itsfar left position. Looking at the lower Key Frames group,
you'll see an assortment of various check boxes with associated sliders
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and buttons. These will all be much less mysteriousin a moment.

a

With the Move/Size tool, deselect the Earth by clicking in an
empty part of the scene window, and now in [ Eosiion
the Key Frames group you'll see that only the =
Camera property is enabled. That's because O Size
Camera Angle and Camera Distance apply to [ Eatation

the scene as awhole, regardless of what's O Testure
selected. N

ec O Calor
Now select the Earth object, and all the check O Tranzsparency
boxes for object-specific properties become ] I:am_er s

available, as at right.

Let’s create the key frames that will tell the Earth how to rotate. In
order to generate a convincing full-cycle rotation, 3DPlus needs us to
provide several snapshots of what the Earth should look like at key
positionsin the cycle. So let’s proceed to define our key frames: a
starting and ending view, and a couple of intermediate views.

a

a

The only property we need to include in the

= :
animation is rotation, so check the Rotation box. Eitatian

Click the # button at the right of the Rotation Key Frame slider.
A key frame marker appears at the far |eft of the dlider
(frame 1).

Click about athird of the way along the Current Frame dider, at
frame 8. We'll create a q = =

key framefor the first ~ =Hmrent — =
intermediate view here.

Choose the Rotate toal. Click onthe “Y” axislabel and drag down
to rotate the Earth until the east coast of South . .
Americaisjust disappearing over the horizon (on
the HintLine “object angle” readout, aY value of
about -105°). When you rel ease the button after
dragging, 3DPlus inserts an automatic key frame
marker at frame 8 at on the Rotation Key Frame
slider.

Note that 3DPlus automatically defines a new key frame each time you
adjust one of the object propertiesincluded in the animation—that is, a
property you've checked in the Key Frames group. (If for any reason
you don’'t want anew key frame, just click the =/ button to delete it.)
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O Click onthe Current Frame dlider again, this
time selecting frame 15. To create the second
intermediate view, drag down on the Y axis until
Australiais centered in the view (Y value of
about 130° on the HintLine). A third key frame
marker appears.

U For the end frame of the sequence, the Earth should be rotated
nearly all the way around, just short of its starting position. To get
to the end frame, type “20" into the Current Frame box, or click
the far right end of the Current Frame slider. The scene will till
look asit did in frame 15.

U DragdownontheY axisto continuethe Earth’'s
rotation. Watch the HintLine and stop rotating
when the Y valueis about 10°. A fourth key frame
marker appears at the far right of the Rotation
Key Frame dlider.

O Now click the A Play button and you'll see the Earth rotate!
To make it rotate continuously, click the g Loop button.

Congratulations! Y ou’ve just made the Earth move.

Editing animations

If you've just completed the mini-lesson above, or have created an
animation using a Wizard (or perhaps one of your own design), the Edit
Panel on the Animation toolbar will show the key frames defined for
each object in the scene. If there’s more than one object, you'll need to
click each oneindividually to see its key frames. Note that animations
will often include static objects that don’t move at all during the
sequence.

It's easy to edit animations by adding new objects to the scene (with or
without movement), replacing Wizard text with your own, and so on.
Here are some additional pointers on working with the Animation
toolbar:

¢ You canclick on any key frame marker to jump to that frame.

¢ For arapid preview, drag the Current Frame dlider.

¢ |f aparticular object transformation appears jerky, first determine
which property and key frame seem to be the source of the
problem. Then go to that key frame and either:
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= Adjust the object property itself or

= Move the key frame marker dlightly (e.g. drag it left or right a
frame at atime).

Moving two key frames closer together has the effect of speeding
up the transformation between them; moving them apart slows
things down.

To change the overall playback speed, type a new value into the
Speed box and press Enter. Bear in mind that playback in 3DPlus
may not match the frame-per-second rate shown in the box. That
value, will, however, be used when the animation is exported. To
determine an optimal rate setting, always preview the exported
.GIFfilein abrowser or GIF editing program.

To change the sequence length, simply type a new value into the
Total box and press Enter (but see the following paragraph).
Frames are added or subtracted at the end of the sequence. In
general, thefinal .GIF file will be more compact if it has fewer
frames. There' s nothing fixed about the default length of 20
frames. Many convincing animations can be accomplished in 10
frames or less.

Be careful if adding or subtracting frames after you’ ve defined key
frames. Obviously, the resulting sequence won't have the same
number of frames—and there’ s no undo for this action—so decide
beforehand what you want 3DPlus to do with the existing key
frames.

= To preserve the current “spread” of key frames between the first
and last frames, keep the Interpolate Key Frames box checked.
For example, if you had a 12-frame sequence with key frames on
1, 6, and 12, and increased the total framesto 20 with
interpolation, the resulting key frames would be on 1, 10, and 20.
= Uncheck the box to leave existing key frames exactly where
they are. With no interpolation, the key framesin our 12-to-20-
frame example would remain at 1, 6, and 12. This would be useful
if you planned to add add more motion to the end of the existing
sequence. Note that if you subtract frames with no interpolation,
key frames at the end of your sequence may be deleted.
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Aside from printing a scene out directly, there are two basic ways of
incorporating a 3DPlus image in a publication or other graphic context:
exporting and OLE.

Exporting

Exporting means converting a 3DPlus scene to an external file format,
as opposed to saving it in the native .3D2 format.

When you export, the entire scene window gets converted to an anti-
aliased bitmap graphic. Y ou can fine-tune the graphic in a paint editing
program (like Serif PhotoPlus), so you don’t have to worry if there's
extra background showing around the scene objects. Y ou can crop the
image later. But make sure you' re satisfied with the composition,
lighting, and colors in the scene before you export—it’s much more
difficult to change those | ater.

Remember that the scene will be exported at its actual size, as specified
in the File/Scene Setup dialog. If you're using a separate paint
program, you can always downsize the image later on.

When you’ re done you can import your 3DPlus effect as a graphic, into
your favorite DTP, word-processor or any other application you
choose.

Tip: To preview how the scene will appear when anti-aliasing is
applied, click the Render Preview button on the Standard toolbar.

For additional details on export options, see the How To topic
“Exporting” in online help.

To export a static scene, choose Export... from the File menu. Use the
Save as Type pull-down menu to specify the export file format.
Provide afile name and folder location, and click Save.

To export an animation, choose Export Animation... from the File
menu and provide a file name and folder location.

Export settings

In the Export dialog, set any options available for the particular image
and file format. The appearance of the dialog changes somewhat
depending on the format. One standard feature is the Image Preview
window, which provides an accurate rendering of how your scene will
look using the current combination of settings. Y ou can zoom in and
out, drag the scene to center it in the window, and experiment with
different export options until the results are satisfactory.
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¢ Bit Depth: Bit depth relates to the number of colorsin the
exported image. For example, a bit depth of 4 bits per pixel can
store 16 values; 8 bits per pixel, 256, and so on. 16-bit images have
roughly “thousands’ of values to describe each pixel’s color, and
24-bit images have “millions.” Of course, images with higher bit
depth take up more disk space. Choose the bit depth that
corresponds to the number of colors in the exported image. For
256-color images, you have the option of applying either an
Optimized or a Web-safe palette..

+ Palette: A color paletteis atable of color values that gets stored
with any image having 8 bits (256 colors) or less. If you're
exporting at 8 bits (256 colors) or less:
= The default Optimized setting lets the 3DPlus export filter
determine the best colorsto apply. This generally resultsin smooth
color gradations and quite acceptable appearance when viewed on
aHigh Color (16-hit) or better color display.

» Choose Web-safe to reduce the colors to only those found in
the 216-color palette used by Web browsers on limited-color
systems. Thiswill ensure that an image you place on a Web page
won't change its appearance when viewed on such systems.

+ Dithering: Dithering comes into play with images being reduced
to 8 bits (256 colors) or less. It's amethod of approximating colors
outside the actual image palette—for example, by alternating
pixels of red and blue from within the palette to produce the visual
impression of a purple color that's not in the palette. While
dithering can degrade solid-color areas, with 3D imagesit’s
usually more important to preserve subtle gradations of color.
= To preserve gradations of color and/or an image background,
dithering is clearly the best choice. Y ou can choose either Ordered
or Error Diffusion dithering. The former produces a discernably
patterned effect, while the latter tends to average away the patterns
for amore natural result.
= Tominimizefile size, or if you happen to have an image with
few colors, you can opt for no dithering—and the export filter will
pick “nearest-match” color values from the palette being applied.

Y ou may see some color shifting, but the solid color areas will be
preserved.
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¢ GIF Options: .GIF files support transparency—one reason they’re
commonly used over backgrounds on Web pages. If your scene
uses a solid color background, 3DPlus gives you the option of
exporting as .GIF with transparency—so the background color
goes clear and “drops out.” In this mode you can either turn anti-
aliasing off for a sharper edge, or leaveit on, in which case you'll
get bits of the background color around the edges of objectsin the
scene.
Tip: For aGIF that blends smoothly with the color of a Web page,
match your 3DPlus scene’ s background color to that of the Web
page, and export as transparent with anti-aliasing on.

¢ Compression: Compression schemes, which apply different
algorithms to encode the image information with fewer total bits
and bytes, are used in many formats. Depending on the format,
3DPlus may include a choice of compression scheme. In general,
use the default setting unless you know for afact that some other
schemeis called for.
With the .JPG format, recommended for photographic
backgrounds, you can set the level of quality desired using a dlider.
Asyou might expect, the highest-quality setting uses least
compression, with no loss of image quality but the largest file size.
The lowest-quality setting applies maximum compression for
smallest size, but yields rather poor quality.

OLE (Object Linking and Embedding)

Exporting 3DPlus files as bitmap graphics is appropriate when you're
working with an application that requiresimagesin a specific format
(such as .JPG or .GIF for a Web page editor), or if you need to edit the
graphic using a paint program. The drawback of exporting is that you
lose the ability to edit the scene itself in 3DPIus.

Many applications—for example, Serif’s desktop publishing program
PagePlus—allow you to insert a 3DPlus scene as an OLE object. This
means you can still use 3DPlus to modify the scene later, if necessary.
For example, you can change the text in atext object or ater the color
scheme without having to start from scratch.

In some situations, exporting (as described earlier) may be your only
choice. For example, if your graphic requires a transparent background,
you'll need to export to the .GIF format. Also, you may find that OLE
can be slow and cumbersome due to the amount of bitmap data
required for displaying and printing 3DPlus objects at suitable quality.
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Toinsert a3DPlus OLE abject into a client application, choose the
application’s Insert Object... command, usually found on its Edit
menu, and select “ Serif 3DPIus 2.0” from the list of object types. Then,
to insert asaved 3DPlus (.3D2) file, choose the Create from File
option and locate the file name. Check the Link box to link the object or
leave the box unchecked to embed the object (so it’s independent of the
original file). Or, to create a new 3DPlus object, choose the Create
New option. 3DPlus opens with the Startup Wizard (or a blank scene
window if the Wizard is turned off). When you’ ve created the scene,
choose Update from the File menu to insert the scene as an object (or
update the image already there) without closing 3DPlus.

To edit a 3DPlus abject in any application, double-click the 3DPlus
OLE object within the application, or select the object and choose the
application’s Edit Object command. In Serif PagePlus, either action
will launch 3DPlus, displaying the scene ready for editing.

Other OLE settings

In some applications, including Microsoft Word and PagePlus, resizing
the object will trigger 3DPlus to regenerate the bitmap data to match
the new size of the object.

3DPlus provides OLE settings for resolution (number of dots per inch)
and anti-aliasing (smoothing) that control how much bitmap datais
used to display the 3DPlus object.

You can set these values using View/OLE Render Quality.... In
general, the higher you set the resolution or anti-aliasing values, the
more work your computer hasto do to display the object—so set the
values no higher than necessary to obtain the level of quality you
require.

For additional details on using OLE, see the How To topic “Linking
and embedding” in online help.



